1 Mathematica Basics
This chapter is an introduction to Mathematica. We briefly describe many of the most
important and basic elements of Mathematica and discuss a few of the more common
technical issues related to using Mathematica. Since our primary goal is to use Mathematica
to help us understand calculus, you should not initially spend a great amount of time pouring
over the details of this chapter, except as directed by your professor. Simply familiarize
yourself with what’s here, and refer back to it later as needed.

1.1 Getting Started
Any new user of Mathematica must understand several basic facts concerning the user
interface, syntax, and the various types of objects that one encounters in using Mathematica.
This section is a cursory look at some of these fundamentals.

‡ The Mathematica “Front End”
When you start up Mathematica, the first thing you see is a window displaying the contents
of a “notebook.” This window is displayed by Mathematica’s front end. The front end is
the interface between you and the Mathematica kernel, which does the computations. The
following is a typical (simple) notebook in a front end window.

A Mathematica notebook is composed of cells. On the right side of the window you see cell
brackets. Each cell in the notebook shown above is either an input cell, an output cell, or a
graphics cell. There are several other kinds of cells. Some of these are text, title, and section.
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Also notice the horizontal line near the bottom of the window. This indicates the insertion
point for the next new cell. To enter a command into a notebook, simply begin typing. The
default cell type is input. When you’re done typing, just press shift-return (on a Macintosh,
you can also use the “enter” key.) To evaluate an existing input cell, simply click anywhere
inside the cell (or on the cell bracket) and press shift-return (or enter).
To create a cell between two existing cells, move your cursor over one of the cells toward
the other until the “I-beam” cursor becomes horizontal. Then click, and a horizontal line will
appear, indicating the desired insertion point. To delete a cell, click on its bracket and then
choose Clear from the Edit menu or simply press the „ key
Palettes. You can enter mathematical expressions so that they appear essentially the same as
you would write them on paper or see them in your textbook. For example, to define the
function f HxL =

x2 + 1 , we could use the “Input Form”

f@x_D := Sqrt@x ^ 2 + 1D

or we could use “Standard Form”:
f@x_D :=

x2 + 1

There is a vast set of keystroke combinations for typing such
expressions. However, at first, you will probably want to take
advantage of one or more or the standard palettes that are available. The image to the right shows the BasicInput palette.
Clicking on one of the palette’s buttons places the corresponding
characterêexpression at the current input location. This particular
palette probably appears by default when you start Mathematica,
but if not, you can access it or any of the other palettes through
your Palette menu.
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‡ The Documentation Center
Mathematica’s Documentation Center may be accessed by selecting Documentation Center
from the Help menu. Among the wealth of information available through the Documentation Center are descriptions of all of Mathematica’s built-in functions, including examples
of their use and links to related tutorials. You can also enter commands from within the
Documentation Center. (Whatever you change there will not be saved.)

The Documentation Center provides a great deal of tutorial material. If you’re a beginner,
we suggest that you peruse the tutorials found by entering each of the following in the
Documentation Center search field.
tutorial/UsingTheMathematicaSystemOverview
tutorial/InputAndOutputInNotebooksOverview
tutorial/BuildingUpCalculationsOverview
tutorial/EnteringTwoDimensionalExpressionsOverview
tutorial/GraphicsAndSoundOverview

(Hopefully future updates to the Documentation Center will provide a more convenient way
to access these and other tutorials.)
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‡ Basic Calculations
Mathematica allows multiplication to be indicated in three ways. Expressions separated by a
space are multiplied. (Note that the system automatically replaces the space with µ.)
217 µ 5713
1 239 721

An asterisk between expressions indicates multiplication.
321 * 5.479
1758.76

When there is no ambiguity, juxtaposed expressions (without spaces) are understood and
multiplied.
2x
2x

More than one command can be given in one input cell. A single input cell may consist of
two or more lines. A new line within the current cells is obtained by pressing “return.”
Commands on the same line within a cell must be separated by semicolons. The output of
any command that ends with a semicolon is not displayed.
a = 17 ê 13 + 211 ê 93;
b = 23 a; c = Ha + bL ê 51
34 592
20 553

The percent sign % refers to the last output (not necessarily the preceding cell).
3 ê 17 + 1 ê 5
32
85

%2
1024
7225

If the last command on any line is not followed by a semicolon, its result is displayed. This
effect is very handy for showing intermediate steps in a calculation. The following computes
25!
H.1L3 H.9L22 (a binomial probability).
3! µ 22!
25 !
% ê H3 ! µ 22 !L
3

22

% * .1 .9

15 511 210 043 330 985 984 000 000
2300
0.226497

¤ You should avoid use of the percent sign as much as possible~especially in separate cells.
It is far better to give names to results and to use those names in subsequent calculations.
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‡ Parentheses, Brackets, and Braces
The syntax of Mathematica is absolutely strict and consistent (and quite simple once you get
used to it). For that reason, there are some differences between Mathematica’s syntax and
the often inconsistent and sometimes ambiguous mathematical notation that we’re all used
to. For example:
Parentheses are used only for grouping expressions.
x Hx + 2L

2

x H2 + xL2

Brackets are used only to enclose the argument(s) of a function.
Cos@p ê 3D
1
2

Braces are used only to enclosed the elements of a list (which might represent a set, an
ordered pair, or even a matrix).
81, 2, 3, 4<
81, 2, 3, 4<

Consequently, Mathematica does not understand what you intend by entering any of these
expressions, for example:
@x + y H1 - yLD

2

Syntax::tsntxi : "@x + y H1 - yLD" is incomplete; more input is needed.
Syntax::sntxi : Incomplete expression; more input is needed.

H1, 2L

Syntax::sntxf : "H" cannot be followed by "1, 2L".
Syntax::tsntxi : "1, 2" is incomplete; more input is needed.

Sin HpL
p Sin

In these first two instances, we were lucky to get an error message. But in the last one,
Mathematica simply multiplied the expressions p and Sin~with no complaint at all!

‡ Symbolic vs. Numerical Computation
Computations are typically done symbolically (and therefore exactly), unless we request
otherwise.
123 í

768

41 3
16

One way to obtain a numerical result is to use the numerical evaluation function, N.
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One way to obtain a numerical result is to use the numerical evaluation function, N.
NA123 ë

768 E

4.43838

We also get a numerical result if any of the numbers in the expression are made numerical
by use of a decimal point.
123. í

768

4.43838

Unless we cause a numerical result, Mathematica typically returns an exact form, which in
many cases is identical to the expression entered.
CosB p F
12
1+ 3
2

2

Log@2D
Log@2D

‡ Names and Capitalization; Basic Functions
All built-in Mathematica objects~functions, constants, options, etc.~have full names that
begin with a capital letter (or in the case of certain “global” parameters, a dollar sign
followed by a capital letter).
Sin@p ê 3D
3
2

PrimeQ@22 801 763 489D
True

SolveAx2 + x - 12 ã 0, xE
88x Ø -4<, 8x Ø 3<<

These full names are used internally by Mathematica, even when it is far more natural for us
to use a symbolic form such as x + 7. FullForm lets us see the internal representation of
an expression.
FullForm@x + 7D
Plus@7, xD

FullFormAx == x2 E
Equal@x, Power@x, 2DD

¤ When the name of a built-in Mathematica object is made of two or more words, all of the
component words are capitalized. Some typical Mathematica-style names are FindRoot,
PlotRange, AspectRatio, NestList, etc. In almost all cases the component words
are spelled out in full.
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When the name of a built-in Mathematica object is made of two or more words, all of the
component words are capitalized. Some typical Mathematica-style names are FindRoot,
PlotRange, AspectRatio, NestList, etc. In almost all cases the component words
are spelled out in full.
All of the familiar “elementary functions” are built-in. In some cases~if you remember to
capitalize the first letter and to use brackets instead of braces~you would guess correctly
how to use one of those functions. For example,
Sin@p ê 12D
-1+ 3
2

2

There are a few things in this regard that should be pointed out. First, the inverse trigonometric functions use the “arc-function” convention:
ArcTan@1D
p
4

ArcCos@1 ê 2D
p
3

¤ Also, the natural logarithm is Log, not Ln.
Log@ED
1

‡ Algebraic Manipulation
Mathematica is an example of a type of software system that is often called a computer
algebra system. In addition to numerical computations, a computer algebra system also does
symbolic computation including the manipulation of algebraic expressions. Mathematica has
a number of functions for this purpose. Among these are Expand, Factor, Together,
and Apart.
ExpandAHx + 5L3 H2 x - 1L E
2

125 - 425 x + 215 x2 + 241 x3 + 56 x4 + 4 x5

FactorAx3 + 2 x2 - 5 x - 6E
H-2 + xL H1 + xL H3 + xL

TogetherBx +
2 + x + x3
1 + x2

ApartB

x
F
x2 + 3 x + 2

- 1 + 2
1+x 2+x

¤

2 F
x2 + 1
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Notice that Mathematica does not automatically simplify algebraic expressions:
x H3 - xL - 5 x2 + Hx - 1L H2 x + 3L
H3 - xL x - 5 x2 + H-1 + xL H3 + 2 xL

Simplify can be used for this purpose.

SimplifyAx H3 - xL - 5 x2 + Hx - 1L H2 x + 3LE
-3 + 4 x - 4 x2

‡ Plotting Graphs: An Introduction to Options
Mathematica is extremely good at creating graphics to help us analyze problems. We will be
primarily interested in graphing functions of one variable. This is done with Plot.
The function f HxL = sinHp x H3 - xLL is graphed on the interval 0 § x § 3 as follows.
Plot@ Sin@p x H3 - xLD, 8x, 0, 3<D
1.0
0.5
0.5

1.0

1.5

2.0

2.5

3.0

-0.5
-1.0

Notice that two arguments are provided to Plot. The first is our function in the form of an
expression, and the second is a list with three members, specifying (i) the name of the
variable, (ii|iii) the left and right endpoints of the interval.
There are numerous ways that we could have affected the appearance of the plot by specifying options. Among the options for Plot are PlotRange, Ticks, AxesLabel,
AspectRatio, and PlotStyle.
The following creates a plot with labelled axes with no tick marks. Note that the arrow
character is typed as Â->Â. (Actually, just -> will do.)
Plot@Sin@p x H3 - xLD, 8x, 0, 3<,
Ticks Ø 881, 2, 3<, 8-1, 1<<, AxesLabel Ø 8x, y<D
y
1

1

2

3

x

-1

Notice that the following plot chops off high and low parts of the curve.
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Notice that the following plot chops off high and low parts of the curve.
PlotB

SinA2 x2 E
x2 + 1

, 8x, 0, 10<F

0.20
0.15
0.10
0.05
2

-0.05

4

6

8

10

-0.10
-0.15

This can be cured with the PlotRange option.
PlotB

SinA2 x2 E
x2 + 1

, 8x, 0, 10<, PlotRange Ø AllF

0.6
0.4
0.2

2

4

6

8

10

-0.2

Without our specifying AspectRatio Ø Automatic, the following semicircle would be
stretched vertically.
PlotB

1 - x2 , 8x, -1, 1<, AspectRatio Ø AutomaticF
1.0
0.8
0.6
0.4
0.2

-1.0

-0.5

0.5

1.0
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To plot more than one function at once, we give Plot a list of functions.
PlotA9x ‰-xê2 Cos@p xD, x ‰-xê2 Sin@p xD=, 8x, 0, 12<E
0.6
0.4
0.2
2

-0.2
-0.4
-0.6

4

6

8

10

12

When plotting multiple functions, it is often desirable to plot them with different styles. The
PlotStyle option lets us do that.
PlotA9

3

x , x, x3 =, 8x, 0, 2<, PlotRange Ø 80, 1.6<,

PlotStyle Ø 88Dashing@8.02<D<, 8Red<, 8Thickness@.007D<<E

1.5

1.0

0.5

0.0

0.5

1.0

1.5

2.0

‡ Variables
As we mentioned earlier, all built-in Mathematica objects begin with an upper-case letter.
For that reason, it is usually a good idea to use variable names that begin with a lower-case
letter. In this manual we will loosely follow that convention. It is also good practice to give
meaningful names to variables and never to make assignments to single letter variables.
¤ Assignments to variables are remembered by Mathematica (for the duration of one “kernel
session”) until the variable is “cleared.” This is probably the single most important thing to
remember when you run into difficulties using Mathematica. (We will have more to say on
this in Section 1.8.)
piSixths = N@p ê 6D
0.523599

Clear@piSixthsD; piSixths
0.523599
piSixths
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Assignments in Mathematica are made in two ways: (i) with a single equal sign, or (ii) with
a colon followed by an equal sign. For simple assignments such as
radius :=

10. ê p

it makes little difference which method is used. In this particular case, the consequence of
using := is that radius has not yet been computed. (Also notice that no output is produced
when := is used.) The evaluation has been delayed until we cause it to be done~for example, by entering
radius
1.78412

A better example to illustrate delayed evaluation with := is as follows. If we assign a plot to
a variable with :=, then no plot is created. The variable is assigned the command itself, not
the result.
1 - x2 , 8x, -1, 1<F

graph := PlotBx
graph
0.4
0.2
-1.0

-0.5

0.5

1.0

-0.2
-0.4

If we assign a plot to a variable with =, then the plot is created and the variable is assigned
the resulting graphics object.
graph = PlotBx

1 - x2 , 8x, -1, 1<F

0.4
0.2
-1.0

-0.5

0.5

1.0

-0.2
-0.4

We will address these issues again in Section 1.2. (See also Exercise 9 in this section.)
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‡ Tips and Shortcuts
We end this quick tour of Mathematica with a few tips and shortcuts with respect to typing
expressions.

† Entering Exponents, Radicals, and Fractions
To enter an exponent or superscript, press ‚-[6]. (Note that this is analogous to the ˜[6] caret (^), which is used for exponentiation in InputForm.) To leave the resulting
exponent “box,” press [Ø] or ‚-¯.
To enter a subscript, press ‚-[-]. (This is analogous to the ˜-[-] underscore character
(_), which is used to create subscripts in the TEX typesetting language.) To leave the
resulting subscript “box,” press [Ø] or ‚-¯.
To enter an expression involving a square root, press ‚-[2]. To leave the resulting square
root box, press [Ø] or ‚-¯.
To enter a fraction, press ‚-[/]. To move from the numerator box to the denominator box,
press Í To exit the fraction, press [Ø] or ‚-¯.

† Greek Letters and Other Special Characters
Many special characters and symbols can be typed easily by pressing the Â key before and
after typing some easily remembered standard character(s). For instance, to type the Greek
letter a (alpha), just type Â a Â or Â alpha Â. Other Greek letters can be typed
similarly.
Other shortcuts for common special characters include:

Â ee Â produces the constant ‰, the base of the natural logarithm.
Â ii Â produces the imaginary number Â =
Â int Â produces an integral sign Ÿ .

-1 .

Â pd Â produces a derivative operator !.
Â inf Â produces an infinity symbol ¶ .
Of course, you may prefer to use the buttons on the BasicInput palette.
We should also point out that the familiar numbers denoted by ‰, Â, and p can be entered as
such or as E, I, and Pi, respectively.
8‰ ã E, Â ã I, p ã Pi<
8True, True, True<

Be careful to notice, however, that an ordinary e is not the same as ‰, and an ordinary i is not
the same as Â.
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Ï Exercises
1. Compute both an exact and a numerical value for each of the following numbers.
a) I233 - 3 H117 - 48L2 M ì

75 - 57

b) cos

319 p
12

83!

c) 111!

2. Use Simplify on each of the following.
a) lnI2‰5 M

b) 1 + cos 2x

c)

d) ln 2981

x + Hx Hx - 1LL3 - 4
x2 + x - 6

3. Factor each of these polynomials:
a) 6x3 + 47x2 + 71x - 70

4. Plot the function f HxL =
a) no options

b) 12x6 - 56x5 + 100x4 - 80x3 + 20x2 + 8 x - 4

sinHx3 L
on the interval 0 § x § 1 with:
x3

b) PlotRangeØ All

c) PlotRangeØ All, AspectRatioØ Automatic
5. Create a plot containing the graphs of y = x2 and y = x5 over 0 § x § 2 with:
a) no options

b) PlotRangeØ All

d) PlotStyleØ {Red,Blue}

c) PlotRangeØ {0,2}

e) PlotStyleØ {{Red,Thick},{Blue,Thick}}

6. Look up each of the following functions in the Documentation Center, and then plot them
on the indicated interval.
a) Floor, 0 § x § 10

b) PrimePi, 0 § x § 100

7. Use the Documentation Center to learn what RandomReal[] and RandomInteger[]
do. Then enter and the following and explain the output:
GraphicsRow@8Plot@RandomReal@D x, 8x, 0, 1<D,
Plot@RandomInteger@D x, 8x, 0, 1<D<D

8. RandomReal and RandomInteger provide a good illustrations of the difference
between using = and using := in an assignment. Enter each of the following several times.
Describe and explain the difference in the results.
r = RandomInteger@100D; Table@r, 810<D

and

r := RandomInteger@100D; Table@r, 810<D
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1.2 Functions
‡ Defining Functions
† Blank
When defining a function, it is essential to follow each argument by a Blank (or
“underscore”). Also, recall that the arguments of a function are enclosed by brackets. For
example, we would define the function f HxL = x3 - 2 by entering
f@x_D := x3 - 2 x

Then we can evaluate the function at any number
f@3D
21

or plot its graph:

Plot@f@xD, 8x, -2, 2<D
4
2

-2

-1

1

2

-2
-4

‹ Note that the Blank appears next to x only on the left side of the expression. Also, when
defining a function with more than one argument, a Blank must follow each one. For
instance:
g@x_, y_, z_D := x + y + z
g@1, 2, 3D
6

† Set (=) versus SetDelayed (:=)
Definitions of functions~and assignments of expressions to variables in general~can be
made using either “equal” or “colon-equal.” The difference between these two ways is
described by the full Mathematica names of the = and := symbols, which are Set and
SetDelayed.
When an assignment is made using Set, any calculations that are indicated on the right side
are done as the assignment is entered. When an assignment is made using SetDelayed,
any calculations that are indicated on the right side are delayed until the defined expression
is used.
In many cases, such as in the definitions of f and g above, it makes no difference which is
used. To see a simple example that indicates the importance of using Set rather than
SetDelayed, let’s suppose we want to define f HxL to be the derivative of Hx + 1L cos x. If
we enter
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In many cases, such as in the definitions of f and g above, it makes no difference which is
used. To see a simple example that indicates the importance of using Set rather than
SetDelayed, let’s suppose we want to define f HxL to be the derivative of Hx + 1L cos x. If
we enter
f@x_D := !x HHx + 1L Cos@xDL

notice what happens when we try to evaluate f H2L:
f@2D
General::ivar : 2 is not a valid variable. à

!2 H3 Cos@2DL

However, if we enter

f@x_D = !x HHx + 1L Cos@xDL
Cos@xD - H1 + xL Sin@xD

then f works the way we want it to:
f@2D
Cos@2D - 3 Sin@2D

When is it important to use SetDelayed rather than Set? Here’s a simple example:
Suppose that we want to plot the graph of sin kx for several values of k and that we decide to
define a function as follows to create each of the desired plots.
plotSin@k_D := Plot@Sin@k xD, 8x, 0, 2 p<D

For instance, with k = 2, we get the following graph:
plotSin@2D

1.0
0.5
1

2

3

4

5

6

-0.5
-1.0

But what would have happened if we used = rather than := in the definition of plotSin?
Mathematica would attempted to plot the graph of sin kx immediately when the definition is
entered. This doesn’t work because k has no numerical value, and an empty plot results.
plotSin@k_D = Plot@Sin@k xD, 8x, 0, 2 p<, PlotRange Ø AllD
1.0
0.5
-1.0

-0.5

0.5

1.0

-0.5
-1.0

The empty plot that was produced and assigned to plotSin[k_] will now be the “value”
of plotsin[k] for any k; for instance:
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The empty plot that was produced and assigned to plotSin[k_] will now be the “value”
of plotsin[k] for any k; for instance:
plotSin@2D
1.0
0.5
-1.0

-0.5

0.5

1.0

-0.5
-1.0

‡ Applying Functions with @ and //
Suppose that we define a simple function such as
f@x_D := x Hx - 1L

Naturally, we could evaluate this function at, say, x = 3, by entering
f@3D
6

There are two other ways to do the same thing. We can evaluate f at 3 by entering
fü3
-1

On the other hand, we can apply f to 3 like this:
3 êê f
6

We will use this postfix method of function application frequently, often for the purpose of
applying either Simplify to some expression or N to some numerical calculation. For
example, we will use the following style when doing a symbolic calculation:
2 x + x H5 x + 1L êê Simplify
x H3 + 5 xL

When doing an exact numerical calculation, we will commonly use a style that is similar but
displays the exact value followed by the numerical value:
585 í 33

% êê N
65
11

0.732933

‡ Piecewise-defined Functions

Mathematica Basics

17

‡ Piecewise-defined Functions
Mathematica has two primary logical functions that we can use to enter definitions of
piecewise- defined functions. These are If and Which. If usually works best for functions
with two pieces, such as
x,
if x § 1;
f HxL = ;
x - 2, if x > 1.
This function can be entered and plotted as follows.
f@x_D := If@x § 1, x, x - 2D
Plot@f@xD, 8x, -1, 3<D
1.0
0.5

-1

1

2

3

-0.5
-1.0

More complicated functions are better handled with Which. For example, the function
1, if x § -1
f HxL = -x, if - 1 < x § 1
-1, if x > 1
can be entered and plotted as follows.
f@x_D := Which@x § -1, 1, -1 < x § 1, -x, x > 1, -1D
Plot@f@xD, 8x, -3, 3<D
1.0
0.5

-3

-2

-1

1

2

3

-0.5
-1.0

† Piecewise
Piecewise was new in Mathematica 5.1 and is similar to Which. While Which must be
supplied with an alternating sequence of conditions and values, i.e.,
Which[ cond1 , val1 , cond2 , val2 , …],
Piecewise takes a single list containing value-condition pairs, as in
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Piecewise takes a single list containing value-condition pairs, as in
Piecewise[ {{val1 , cond1 }, {val2 , cond2 }, …} ]
For example, the function
1, if x § -1
f HxL = -x, if - 1 < x § 1
-1, if x > 1
can be input as follows. Notice the automatic display of the output in “left-bracket form.”
f@x_D = Piecewise@881, x § -1<, 8-x, -1 < x § 1<, 8-1, 1 < x<<D
1
x § -1
-x -1 < x § 1
-1 1 < x

It is also possible to enter such a definition in the same left-bracket form as follows: Press
Â pw Â followed by ‚Á. Then you’ll have a template like this:
µ

Ñ Ñ
Ñ Ñ

Pressing

‚Á again will add another row.

† Abs, Floor, and Mod
There are a handful of built-in piecewise-defined functions, including Abs, Floor, and
Mod, whose graphs are shown below.
GraphicsRow@
8Plot@Abs@xD, 8x, -1, 1<D, Plot@Floor@xD, 8x, -2, 3<D,
Plot@Mod@x, 1D, 8x, 0, 3<D<D
1.0
0.8
0.6
0.4
0.2
-1.0 -0.5

2
1
-2
0.5

-1

-1

1

2

3

1.0
0.8
0.6
0.4
0.2

-2

1.0

0.5 1.0 1.5 2.0 2.5 3.0

The following functions are built with Abs.

GraphicsRow@8Plot@Abs@Cos@xD - .5D, 8x, 0, 4 p<D,
Plot@Abs@Abs@xD - 1D, 8x, -3, 3<D<D
2.0

1.4
1.2
1.0
0.8
0.6
0.4
0.2

1.5
1.0
0.5
2

4

6

8

10 12

-3 -2 -1

Floor helped create each of these step functions:

1

2

3
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Floor helped create each of these step functions:
Floor@xD

GraphicsRowA9PlotAH-1L

, 8x, -2, 3<E,

Plot@Sin@p Floor@6 xD ê 6D, 8x, 0, 2<D=E

-2

1.0

1.0

0.5

0.5

-1
-0.5

1

2

3

-0.5

0.5

1.0

1.5

2.0

-1.0

-1.0

A periodic function based on a piece of any graph can be constructed with Mod.
GraphicsRow@8Plot@Sin@p Mod@x, 1D ê 2D, 8x, 0, 3<D,
Plot@Abs@Mod@x, 2D - 1D, 8x, -4, 4<D<D
1.0

1.0

0.8

0.8

0.6

0.6

0.4

0.4

0.2

0.2
-4

0.5 1.0 1.5 2.0 2.5 3.0

-2

2

4

Ï Exercises

1. Enter definitions for each of f HxL = x Hx - 2L2 , gHxL = x - 3, and hHxL = x2 - 1 and then
compute and simplify each of the following:
a) f HgHhHxLLL

b) hHgH f HxLLL

c) f HhHgHxLLL

2. Enter a definition for f HxL = I1 + x2 M . Then create a plot (over -3 § x § 3) showing the
-1

graphs of:

a) f HxL, f Hx - 1L, and f Hx + 1L

3. Using If, define and plot each of a) f HxL =

b) f HxL, f H2 xL, and f H8 xL
-x,
x2

if x < 0

- 1, if x ¥ 0

b) f HxL = ;

1, if x § p ê 2
sin x, if x > p ê 2

4. Using Which, define and plot each of
a) f HxL = 1 -3,

if x < 0

1,

x2 ,

if 0 § x § 2
if x > 2

5. Redo Exercise 4 with Piecewise.
6. Plot each of the functions:

x + 1, if x < 0
b) f HxL = 1 - 2 x, if 0 § x § 1
x - 2, if x > 1
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6. Plot each of the functions:
a) f HxL = Hx - FloorHxLL2

b) f HxL = x H-1LFloorHxL

7. The function Mod provides an easy way to create a periodic function from a simpler function that describes a single period. For example, the function
f0@x_D :=

1 - Hx - 1L

2

describes the top half of the circle with radius 1 centered at H1, 0L. Plot its graph by entering
Plot@f0@xD, 8x, 0, 2<,
AspectRatio Ø Automatic, PlotRange Ø 8-.5, 1.5<D

The corresponding periodic function with period 2 is
f@x_D := f0@Mod@x, 2DD

In a similar manner, define and plot (for 0 § x § 9) a periodic function with period 3 that
agrees with f0 HxL = ‰-x on the interval 0 § x < 3.

8. The unit step function is defined by uHxL = ;

0, x < 0,
Its Mathematica name is UnitStep.
1, x ¥ 0.

a) Using UnitStep, plot the graph of u on -1 § x § 2.

b) Plot f HxL = uHx - 1L on -1 § x § 2 and express f HxL in piecewise form.

c) Plot f HxL = uHx - 1L sinH2pxL on -1 § x § 2 and express f HxL in piecewise form.

d) Plot f HxL = uHx - 2L - hHx - 1L on 0 § x § 3 and express f HxL in piecewise form.

e) Plot f HxL = HuHx - 2L - uHx - 1LL sinH2pxL on 0 § x § 3 and express f HxL in piecewise form.

1.3 Equations
Certainly one of the most frequent mathematical tasks that we need to do is to solve an
equation. In order to be able to solve equations with Mathematica, we first need to understand how equations are formed. The important thing to remember is that double equal signs
are used to form an equation.
Actually, double equal signs constitute a logical test that returns either True, False, or the
equation itself.
2 * 17 - 34 == 0
True

3 == 4
False

x2 - 4 == 0
-4 + x2 ã 0

Notice, however, that Mathematica returns True only when the expressions on each side
are identical. Only the most superficial simplification is done prior to the test, as in:
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Notice, however, that Mathematica returns True only when the expressions on each side
are identical. Only the most superficial simplification is done prior to the test, as in:
2 x + x - 2 == 3 x + 5 - 7
True

Notice that for this equation:

x2 - 4 == Hx + 2L Hx - 2L

-4 + x2 ã H-2 + xL H2 + xL

a nontrivial operation must be done to one side or the other before the expressions become
truly identical. Finally, notice that Mathematica returns an error message if we use a single
equal sign improperly.
3=4
Set::setraw : Cannot assign to raw object 3. à

4

The single equal sign is used only for assignments such as
area = p r2
p r2

Mathematica has three functions for solving ordinary equations. These are Solve,
NSolve, and FindRoot. Solve works very well on polynomial and many other algebraic equations.
SolveA6 x3 - 23 x2 + 25 x - 6 == 0, xE
::x Ø 1 >, :x Ø 3 >, 8x Ø 2<>
3
2

SolveAx4 - 2 x3 - x2 + 6 x - 6 == 0, xE

:8x Ø 1 - Â<, 8x Ø 1 + Â<, :x Ø - 3 >, :x Ø

SolveB

x - 1 + x == 4 +

88x Ø 5<<

3 >>

x + 4 , xF

Solve will also give solutions to trigonometric (or exponential/logarithmic) equations, but
frequently gives a warning.
SolveA2 Sin@2 xD == Cos@xD2 - 1, xE
Solve::ifun :
Inverse functions are being used by Solve, so some solutions may not be found;
use Reduce for complete solution information. à

:8x Ø 0<, 8x Ø -p<, 8x Ø p<, :x Ø ArcCosB-

1
17

F>, :x Ø -ArcCosB

1

F>>

17

Solve will also find solutions of a system of equations. The equations must be given as
elements of a list, i.e., separated by commas and enclosed in braces.
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Solve will also find solutions of a system of equations. The equations must be given as
elements of a list, i.e., separated by commas and enclosed in braces.
SolveA9x2 - y == 1, -x + y == 1=, 8x, y<E
88y Ø 0, x Ø -1<, 8y Ø 3, x Ø 2<<

The solutions of polynomial equations of degree five or greater generally cannot be found in
any exact form. Notice how Mathematica “avoids” the problem:
SolveAx5 - 10 x2 + 5 x + 1 == 0, xE

99x Ø RootA1 + 5 Ò1 - 10 Ò12 + Ò15 &, 1E=,
9x Ø RootA1 + 5 Ò1 - 10 Ò12 + Ò15 &, 2E=,
9x Ø RootA1 + 5 Ò1 - 10 Ò12 + Ò15 &, 3E=,
9x Ø RootA1 + 5 Ò1 - 10 Ò12 + Ò15 &, 4E=,
9x Ø RootA1 + 5 Ò1 - 10 Ò12 + Ò15 &, 5E==

In such situations, we can always resort to numerical solutions. NSolve finds a numerical
approximation to each solution of a polynomial equation, including complex solutions.
NSolveAx5 - 10 x2 + 5 x + 1 == 0, xE

88x Ø -1.22065 - 1.89169 Â<, 8x Ø -1.22065 + 1.89169 Â<,
8x Ø -0.153102<, 8x Ø 0.66946<, 8x Ø 1.92494<<

In many situations where Solve is successful, such as:
SolveAx3 - 10 x2 + 5 x + 1 == 0, xE

99x Ø
9x Ø
9x Ø

10
3

+

10
3

-

10
3

-

3
1
6
1
6

1
I
2

85

I1523+9 Â

I1 + Â
I1 - Â

1691 MM

1ê3

+

1
3

I 1 I1523 + 9 Â

3 M I 1 I1523 + 9 Â

2

2

3 M I 1 I1523 + 9 Â
2

1691 MM

1ê3

1691 MM

1ê3

1691 MM

1ê3

85 I1-Â

3

-

=,

22ê3

I1523+9 Â
85 I1+Â

3 22ê3 I1523+9 Â

3 M

1691 M

3 M

1691 M

1ê3

1ê3

=,
==

it may still be preferable to use NSolve:
NSolveAx3 - 10 x2 + 5 x + 1 == 0, xE

88x Ø -0.152671<, 8x Ø 0.692369<, 8x Ø 9.4603<<

Many equations require the use of FindRoot, which incorporates a numerical procedure.
For example, consider
x2 = cos x.
FindRoot can find only one solution at a time and requires us to supply an initial guess at
the solution we’re looking for. An appropriate initial guess can usually be determined by
examining a graph.
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PlotA9x2 , Cos@xD=, 8x, 0, 1<E

1.0
0.8
0.6
0.4

FindRootAx2

== Cos@xD, 8x, .85<E

0.2

8x Ø 0.824132<

0.2

0.4

0.6

0.8

1.0

Ï Exercises
1. The equation x 3 = x + 1 has one real solution. Find its exact value with Solve and its
numerical value with NSolve.
2. Use Solve to find the solution(s) of each of the systems:
a) 2 x + 3 y = 1, x2 + y2 = 1

b) 3 x - 2 y = 5, 7 x + 3 y = 2

c) x + y + z = 2, x - y + z = 1, x2 + y2 + z2 = 2
3. Use Solve on the underdetermined system
x + y + 2 z = 2, x - 2 y + z = 1
and interpret the result. Try each combination of solve variables: {x,y,z}, {x,y}, {x,z},
and {y,z}. Which gives the “cleanest” solution?
4. For each of the following functions, plot the graph to determine the approximate location of
each of its zeros. Then find each of the zeros with FindRoot.
a) f HxL = ‰-xê2

b) f HxL = x - 9 cos x

c) f HxL = x2 - tan-1 x

5. For each of the following equations, plot both sides of the equation to determine the approximate location of each of its solutions in the specified interval. Then find each of the solutions with FindRoot.
a) sin x cos 2x = cos x sin 3x, 0 § x § 2p

b) sin x2 = sin2 x, 0 § x § p

c) tan x = x, 0 § x § 3p

d) sin x = ‰-x , 0 § x § 4

6. Two spheres have a combined volume of 148 cubic inches and a combined surface area of
160 square inches. Find the radii of the two spheres.
7. Two spheres have a combined volume of 148 cubic inches and a combined surface area of
160 square inches. Find the radii of the two spheres.
8. An open-topped aquarium holds 40 cubic feet of water and is made of 60 square feet of
glass. The length of the aquarium’s base is twice its width. Find the dimensions of the
aquarium.
9. a) Find the equation of the parabola that passes through the points H-1, 1L, H1, 2L, and H2, 3L.
b) Find the cubic polynomial f HxL such that f H1L = f H2L = f H3L = 1 and f H4L = 7.

1.4 Lists
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1.4 Lists
Lists are ubiquitous in Mathematica. A list is anything that takes the form of a series of
objects separated by commas and enclosed in braces, such as:
8a, b, c<

881, 3<, 82, 5<<
8x, 1, 2<

9x2 + y == 2, 2 x - y == 0=

Many built-in commands expect lists for certain arguments. For example, in
Plot@Cos@p Sin@xDD, 8x, 0, 2 p<D
1.0
0.5

1

2

3

4

5

6

-0.5
-1.0

the second argument is a list that specifies the variable name and the interval over which to
plot. In
SolveA9x2 + y == 2, 2 x - y == 0=, 8x, y<E
99y Ø 2 I-1 -

3 M, x Ø -1 -

3 =, 9y Ø 2 I-1 +

3 M, x Ø -1 +

3 ==

each of the two arguments is a list, and the result is also a list (of lists).

‡ Listable Functions
Most built-in Mathematica functions and operations are listable. When a listable function is
applied to a list, it is applied to each element of the list and returns the result as a list. For
example,
81, 2, 3, 4, 5, 6, 7, 8, 9<

2

81, 4, 9, 16, 25, 36, 49, 64, 81<

8882, 3<, 84, 5<<, 886, 7<, 88, 9<<<

999 2 ,

3 =, 92,

1
81, 2, 3, 4, 5<

:1, 1 , 1 , 1 , 1 >
2 3 4 5

5 ==, 99 6 ,

7 =, 92

2 , 3===
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81, 2, 3< + 84, 5, 6<
85, 7, 9<

81, 2, 3< 84, 5, 6<
84, 10, 18<

280,1,2,3,4,5,6,7,8,9,10<

81, 2, 4, 8, 16, 32, 64, 128, 256, 512, 1024<

Cos@80, p ê 4, p ê 2, 3 p ê 4, p<D
:1,

1
2

, 0, - 1 , -1>
2

‡ The Parts of a List
Here’s a simple list:

alist = 82, x, y, 8a, b<<
82, x, y, 8a, b<<

Notice that it has four parts.
Length@alistD
4

Here’s the third part:
alist@@3DD
y

The fourth part is itself a list:
alist@@4DD
8a, b<

Here’s the second part of that sublist:
alist@@4, 2DD
b

This gives the first and third parts:
alist@@81, 3<DD
82, y<

This gives the first through the third parts:
alist@@1 ;; 3DD
82, x, y<

This uses First to extract the first part:
First@alistD
2

This uses Last to extract the last part:
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This uses Last to extract the last part:
Last@alistD
8a, b<

‡ Creating Lists
Mathematica provides three functions that are especially useful for creating lists. These are
Range, Table and NestList.

† Range
Range can be used with one, two, or three arguments. With one argument, it returns a list
of consecutive natural numbers beginning with 1.
Range@10D

81, 2, 3, 4, 5, 6, 7, 8, 9, 10<

Range[a, b] returns a list containing a, a + 1, a + 2, …, a + n, where a + n § b < a + n + 1.
Range@4.5, 15.1D

84.5, 5.5, 6.5, 7.5, 8.5, 9.5, 10.5, 11.5, 12.5, 13.5, 14.5<

A third argument specifies the increment. (The default is 1.)
RangeB0, 1, 1 F
10

:0, 1 , 1 , 3 , 2 , 1 , 3 , 7 , 4 , 9 , 1>
10 5 10 5 2 5 10 5 10

† Table
Table provides an easy way of constructing many kinds of lists. The following computations illustrate its use.
TableAk2 , 8k, 10<E

81, 4, 9, 16, 25, 36, 49, 64, 81, 100<

Table@Table@i - j, 8i, 4<D, 8j, 4<D

880, 1, 2, 3<, 8-1, 0, 1, 2<, 8-2, -1, 0, 1<, 8-3, -2, -1, 0<<

% êê MatrixForm
0
-1
-2
-3

1
0
-1
-2

2
1
0
-1

3
2
1
0
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† NestList
NestList creates lists whose elements are terms of a recursive sequence; that is, given a
function f and a starting point a1 , it creates a list containing a1 , a2, a3 , …, an , where
ak+1 = f Hak L. For example, ten terms of the arithmetic sequence defined by
a1 = 3, ak+1 = 2ak - 1, k = 1, 2, 3, …
can be computed by first defining
f@x_D := 2 x - 1

and then entering
NestList@f, 3, 9D

83, 5, 9, 17, 33, 65, 129, 257, 513, 1025<

Notice that NestList has three arguments. The first is the name of the function, the
second is the first member of the list, and the third is the number of “steps” to be computed
(which is one less than the length of the resulting list).

‡ Manipulating Lists
† Flatten
There are occasions when we need to simplify lists by “merging” smaller lists that it contains. The Flatten command does this. For example:
Flatten@881, 2, 3<, 84, 5<<D
81, 2, 3, 4, 5<

Flatten@888x, y<, 83<<, 84, q<<D
8x, y, 3, 4, q<

† Append and Prepend
We will often need to add elements to the end or beginning of an existing list. These tasks
can be done with Append and Prepend. Here are two examples:
Append@81, 2<, 3D

81, 2, 3<

Prepend@81, 2<, 0D
80, 1, 2<

† Union and Join
Merging two or more lists into one can be done with Union or Join. Union does not
maintain the order of elements:
Union@8a, 2<, 8v, 8<, 8h, s<D
82, 8, a, h, s, v<
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but Join does:

Join@8a, 2<, 8v, 8<, 8h, s<D
8a, 2, v, 8, h, s<

‡ Map and Apply
† Map
A very useful method for applying a non-listable function to each element of a list is provided by Map. Suppose we have a list of ordered pairs of numbers such as
points = Table@82 i, 5 - i<, 8i, 8<D

882, 4<, 84, 3<, 86, 2<, 88, 1<,
810, 0<, 812, -1<, 814, -2<, 816, -3<<

and we would like to create a list containing the sums of the numbers in each ordered pair in
the list. To do this, we can create the function
addpairs@8x_, y_<D := x + y

and “map” it through the list of ordered pairs:
Map@addpairs, pointsD

86, 7, 8, 9, 10, 11, 12, 13<

As an exercise, explain what goes on in the following:

Map@Flatten, 883, 85, 6<<, 8a, 8b, c<<<D

883, 5, 6<, 8a, b, c<<

† Apply
Suppose that we have a function of two variables, say
vol@r_, h_D := p r2 h

and that we would like to compute its value at a pair of numbers in a list, such as
measurements := 83.47, 5.12<

Now entering
vol@measurementsD
vol@83.47, 5.12<D

does not work. A very inconvenient, but effective, workaround is
vol@measurements@@1DD, measurements@@2DDD
193.677

But a far simpler and more versatile approach is provided by Apply function:
Apply@vol, measurementsD
193.677
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It is usually easy to avoid such a situation (by defining vol@8r_, h_<D := p r2 h in this
case), but Apply does give us very nice way to compute the sum or product of the elements
of a list:
Apply@Plus, 82, 5, 8, 12, 13<D

40

Apply@Times, 82, 5, 8, 12, 13<D

12 480

Ï Exercises
1. a) Use Table and Prime to generate a list of the first 100 prime numbers.
b) Generate the same list using only Prime and Range.
2. Generate a list of values of the function f HxL =

sin x
for x = .1, .2, …, 1, first using Table,
x

then without Table.
3. Generate a list of the first 50 odd natural numbers, using:
a) Table;

b) Range;

c) NestList

4. Generate a list of the first 21 powers of 2 (beginning with 20 ), using:
a) Table;

b) Range;

c) NestList

5. Use Table to generate a list of ordered pairs Hx, f HxLL for x = 0,
f HxL = sin x. Can you think of a way to do this without Table?

6. Create a list named waves that contains

1
k

p 2p
,
12 12

…, p, where

sin kx for k = 1, 2, 3, 4, 5. Then plot the expres-

sions in waves by entering

Plot@Evaluate@wavesD, 8x, 0, 2 p<D

Now enter
colors = Map@Hue, Range@.4, 1, .15DD

Plot@Evaluate@wavesD, 8x, 0, 2 p<, PlotStyle Ø colorsD

Then enter
grays = Map@GrayLevel, Range@.8, 0, -.2DD

Plot@Evaluate@wavesD, 8x, 0, 2 p<, PlotStyle Ø graysD

7. a) The function
f@x_D := x5 - 2 x2 - 3 x + 3

has three real zeros. Plot its graph, and create a list named guesses that contains a
rough estimate of each of the zeros.
b) Define the function

getZero@guess_D := FindRoot@f@xD, 8x, guess<D

and find all three zeros of f with one command by entering
Map@getZero, guessesD
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1.5 Rules
Understanding rules is essential to making efficient use of Mathematica. For example, note
that the Solve command returns its results as lists of rules:
soln = SolveA9x2 + x + y2 == 2, 2 x - y == 1=, 8x, y<E

99y Ø 1 I-2 5
9y Ø 1 I-2 +
5

29 M, x Ø 1 I3 10
29 M, x Ø 1 I3 +
10

29 M=,
29 M==

To convert this answer to a list of pairs of numbers, we apply the rules to the list {x,y} as
follows:
8x, y< ê. soln
99 1 I3 10

29 M, 1 I-2 5

29 M=, 9 1 I3 +
10

29 M, 1 I-2 +
5

29 M==

Anticipating this in advance, we might have combined these steps by entering
8x, y< ê. SolveA9x2 + x + y2 == 2, 2 x - y == 1=, 8x, y<E
99 1 I3 10

29 M, 1 I-2 5

29 M=, 9 1 I3 +
10

29 M, 1 I-2 +
5

29 M==

The name of the slash-dot object “/.” that we use to apply rules is ReplaceAll. The
following are some simple examples that illustrate its use.
x2 - x + 1 ê. x Ø 3

7

x + y ê. y Ø x
2x

x y + y z + x z ê. 8x Ø a, y Ø b + c, z Ø 5<
5 a + 5 Hb + cL + a Hb + cL

Ï Exercises
1. Trigonometric identities provide a good context in which to learn about rules and gain a bit
of insight into symbolic computation in general. For example, the sine addition formula can
be applied via the rule
sinAdd := Sin@x_ + y_D Ø Sin@xD Cos@yD + Cos@xD Sin@yD

Notice what happens when the rule is applied to sinH3x + 5yL:
Sin@3 x + 5 yD ê. sinAdd

Cos@5 yD Sin@3 xD + Cos@3 xD Sin@5 yD

The same rule provides the sine difference formula as well.
Sin@t - fD ê. sinAdd

Cos@fD Sin@tD - Cos@tD Sin@fD

This rule also handles expressions with three or more summands, provided we use //.
(ReplaceRepeated) instead of /.:
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This rule also handles expressions with three or more summands, provided we use //.
(ReplaceRepeated) instead of /.:
Sin@a + b + cD êê. sinAdd

Cos@b + cD Sin@aD + Cos@aD HCos@cD Sin@bD + Cos@bD Sin@cDL

a) Enter the definition of sinAdd and construct a similar rule, cosAdd, for the cosine
addition formula. Test both rules on several different expressions.
b) Enter the following multiple-angle expansion formula for sine:

sinMult := Sin@n_Integer x_D Ø Sin@Hn - 1L x + xD ê. sinAdd

Check that this rule works properly by entering
8Sin@2 xD, Sin@3 xD< êê. sinMult

92 Cos@xD Sin@xD, 2 Cos@xD2 Sin@xD + Cos@2 xD Sin@xD=

c) Construct a similar rule, cosMult, for the multiple-angle expansion formula for cosine.
Test it on a few expressions.
d) Notice the result of repeatedly applying all four rules (followed by Expand) by entering
Sin@2 x + yD êê. 8sinAdd, cosAdd, sinMult, cosMult< êê Expand

Then enter Simplify[%] to verify that the expansion is correct.
e) Define the function
trigExpand@expr_D :=
expr êê. 8sinAdd, cosAdd, sinMult, cosMult< êê Expand

and test it by entering

Cos@x + 2 yD + Sin@3 x - yD êê trigExpand
% êê Simplify

f) Finally, create a table of multiple angle formulas for sine by entering

Table@8Sin@k xD, Sin@k xD êê trigExpand<, 8k, 1, 5<D êê TableForm

and create a similar table of multiple angle formulas for cosine.

2. a) Use NSolve to find the zeros of the polynomial f HxL = x5 - 4 x4 + 12 x2 - 9 x + 1.
Convert the result to a list of numbers.
b) Compute the sum of the zeros of f using Total. Combine the entire process into a
single command.
c) Repeat the process in parts (a) and (b) after changing the coefficient of x4 to 3, and then
once again after changing the coefficient of x4 to 1. Try changing the other coefficients to
see if they affect the result. What do you conjecture about the sum of the zeros of a fifthdegree polynomial?
d) Compute the product of the zeros of f using Apply and Times. (See section 1.4.)
Experiment with the coefficients to determine which affect the result. What do you
conjecture about the product of the zeros of a fifth-degree polynomial?
e) Experiment with a few polynomials of other degrees. Do your conjectures depend on
degree? Also, are your conjectures consistent with linear polynomials?

1.6 Graphics
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1.6 Graphics
‡ Graphics Objects and Show
Graphics commands such as Plot create and display graphics objects.
graph1 = Plot@Sin@xD Cos@10 xD, 8x, 0, 2 p<D
1.0
0.5

1

2

3

4

5

6

-0.5
-1.0

graph2 = Plot@8Sin@xD, -Sin@xD<, 8x, 0, 2 p<D
1.0
0.5

1

2

3

4

5

6

-0.5
-1.0

The Show command displays graphics objects, which may consist of two or more combined
graphics objects.
Show@graph1, graph2D
1.0
0.5

1

2

-0.5
-1.0

‡ Graphics Primitives

3

4

5

6
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‡ Graphics Primitives
Graphics primitives are the simple objects of which more complex graphics objects are
built. Two- dimensional graphics primitives include Point, Line, Circle, Disk,
Rectangle, Polygon, and Text.
The following defines a graphics primitive consisting of a series of line sergments connecting the specified points:
zigzag :=
Line@881, 2<, 81, 1<, 83, 2<, 82, 2<, 81, 0<, 83, 1<, 82, 1<, 82, 0<<D

The Graphics command creates a graphics object from the graphics primitive.
Graphics@zigzagD

Here is a list of graphics primitives:

shapes = 8Rectangle@8-2, 1<, 80, 2<D, Circle@81, 1<, 1D,
Disk@80, 0<, .7D, Text@"rectangle", 8-1.5, .8<D,
Text@"disk", 8-1, 0<D, Text@"circle", 81.5, 1.5<D<;

This is the resulting graphics object:
Graphics@shapes, AspectRatio Ø AutomaticD

circle
rectangle
disk

‡ Graphics Directives
Graphics directives affect the way graphics primitives are displayed. Common graphics
directives include Opacity, PointSize, and Thickness, as well as common colors
such as Red, Blue, Orange, and so on. (RGBColor, Hue, GrayLevel, and CMYKColor are available for mixing your own colors.)
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A graphics directive is associated with a graphics primitive by creating a list of the form
{directive, primitive}. More than one primitive can be specified by creating a list of the form
{directive1, directive2, …, primitive}. The following suggests the many possibilities:
redRect = 8Red, Opacity@.67D, Rectangle@8-1, 1<, 81, 2<D<;
thickCircle =
8Thickness@.02D, Opacity@.5D, Green, Circle@81, 1<, 1D<;
purpleDisk = 8Purple, Opacity@.4D, Disk@80, 1<, .7D<;
Graphics@8redRect, thickCircle, purpleDisk<D

Often graphics directives are provided through options such as PlotStyle, AxesStyle,
and Background. For example,
PlotAx2 , 8x, -1, 1<, PlotStyle Ø 8Thick, White<,
AxesStyle Ø Green, Background Ø GrayLevel@.5DE
1.0
0.8
0.6
0.4
0.2
-1.0

-0.5

0.5

1.0

‡ Suppressing and Combining Graphics

Suppose that we want to plot the parabola y = x2 along with the circle of radius 1 ê 2 centered at H0, 1 ê 2L. The following assigns names to plots of the parabola and the circle. The
output of each is surpressed by a semicolon. (That’s new in Mathematica 6.)
curve = PlotAx2 , 8x, -1.4, 1.4<E;

circ = Graphics@Circle@80, .5<, .5DD;

We can now combine the two graphics with Show.
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We can now combine the two graphics with Show.
Show@curve, circ, AspectRatio Ø AutomaticD
2.0
1.5
1.0
0.5
-1.0 -0.5

0.5

1.0

The same thing could be accomplished all at once by entering
ShowAPlotAx2 , 8x, -1.4, 1.4<E,

Graphics@Circle@80, .5<, .5DD, AspectRatio Ø AutomaticE

(This behavior is new in Mathematica 6; in earlier versions the preceding command would
have produced three separate plots.)

‡ GraphicsRow and GraphicsGrid
Two very useful graphics commands are GraphicsRow and GraphicsGrid. With these
we can create composite graphics objects containing rectangular arrays of individual
graphics objects. For instance, let’s create the following four graphics objects:
segment = Graphics@Line@880, 0<, 82, 2<<DD;
circ = Graphics@Circle@80, 0<, 1DD;
parabola = PlotAx2 , 8x, -1, 1<, Axes Ø NoneE;

rect = Graphics@8Gray, Rectangle@80, 0<, 81, 1<D<D;

The following shows these four graphics objects in a one-by-four array:
GraphicsRow@8segment, circ, parabola, rect<D

We would get a two-by-two array instead if we enter

GraphicsGrid@88segment, circ<, 8parabola, rect<<D

Ï Exercises
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Ï Exercises
1. Predict the result of each of the following commands before entering it.
GraphicsRow@Table@Graphics@8Thickness@tD, Orange, Circle@D<D,
8t, .02, .1, .02<DD
GraphicsRow@Table@
Graphics@8PointSize@tD, Point@80, 0<D<D, 8t, .1, 1.1, .25<DD
GraphicsRow@Table@Graphics@8col, Disk@D<D,
8col, 8Red, Blue, Green, Purple<<DD
GraphicsRow@Table@Graphics@8col, Disk@D<D,
8col, NestList@Lighter, Red, 3D<DD
GraphicsRow@
Table@Graphics@8RGBColor@h, 0, 1 - hD, Disk@D<D, 8h, 0, 1, .1<DD
Graphics@Table@8Hue@RandomReal@DD,
Disk@8Cos@tD, Sin@tD<, .25D<, 8t, p ê 6, 2 p, p ê 6<DD

1.7 Animate and Manipulate
One of the most instructive and fun features of Mathematica has always been its ability to
animate graphics. New in Mathematica 6 is the function Animate, which provides a
convenient, simple mechanism for creating animations.
For the sake of comparison, let’s first create a simple table containing graphs of
y = sinHx - fL for various values of the phase shift f. Here f will go from 0 to 2p in steps of
1 (by default).
Table@Plot@Sin@x - fD, 8x, 0, 6 p<,
PlotRange Ø 880, 6 p<, 8-1.1, 1.1<<, AspectRatio Ø .2,
Ticks Ø 8Range@6D p, None<D, 8f, 0, 2 p<D
:

p
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3p

4p

5p
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>
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If we change Table to Animate, we get an animation instead, in which f goes from 0 to
2p continuously. The controls allow you to start, stop, slow down, speed up, and reverse the
animation. Moreover, the slider lets you “manually” move forward or backward through the
animation.
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If we change Table to Animate, we get an animation instead, in which f goes from 0 to
2p continuously. The controls allow you to start, stop, slow down, speed up, and reverse the
animation. Moreover, the slider lets you “manually” move forward or backward through the
animation.
Animate@Plot@Sin@x - fD, 8x, 0, 6 p<,
PlotRange Ø 880, 6 p<, 8-1.1, 1.1<<, AspectRatio Ø .2,
Ticks Ø 8Range@6D p, None<D, 8f, 0, 2 p<D
Φ

Π

2Π

3Π

4Π

5Π

6Π

Using Manipulate instead, we get only the slider control. However, clicking on the
icon at the right end of the slider will reveal animation controls.
Manipulate@
Plot@Sin@x - fD, 8x, 0, 6 p<, PlotRange Ø 880, 6 p<, 8-1.1, 1.1<<,
AspectRatio Ø .2, Ticks Ø 8Range@6D p, None<D, 8f, 0, 2 p<D

¤ Notice in the preceding examples the specification of the PlotRange option. This is
generally necessary to ensure that each plot created corresponds to the same rectangle in the
plane, thereby producing an animation in which any fixed point remains still.
Animate and Manipulate can be used to animate or manipulate any type of expression,
not just graphics.
ManipulateAExpandAHa + bL E, 8n, 1, 20, 1<E êê boldEdge
n

n

a7 ! 7 a6 b ! 21 a5 b2 ! 35 a4 b3 ! 35 a3 b4 ! 21 a2 b5 ! 7 a b6 ! b7

Here are two simple examples that use a different ControlType:
ManipulateAExpandAHa + bL E,
n

8n, 1, 15, 1<, ControlType Ø SetterBarE

ManipulateAxy , 8x, 1, 15, 1, ControlType Ø SetterBar<,
8y, 1, 15, 1, ControlType Ø SetterBar<E

Ï Exercises
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Ï Exercises
1. The following creats a Manipulate object that plots the graph of y = sinHa xL + sinHbxL for
manipulable angular frequencies a and b of the individual terms. Enter the command and
experiment with the two sliders. Then describe what you observe whenever the value of a
“crosses over” the value of b or vice versa.
Manipulate@Plot@Sin@a tD + Sin@b tD,
8t, 0, 5<, PlotRange Ø 8-2, 2<, PlotPoints Ø 40D,
8a, 50, 100<, 88b, 100<, 50, 100<D

This demonstrates the same phenomenon with sound:

Play@Sin@H950 + 10 tL tD + Sin@1000 tD, 8t, 0, 5<D

And this is the same thing in stereo:

Play@8Sin@H950 + 10 tL tD, Sin@1000 tD<, 8t, 0, 5<D

This is the phenomenon known as beats, which is useful in tuning string instruments by ear.
2. In this exercise, we will build up some simple and strangely interesting pieces of Mathematica-generated “art.” Begin by entering
r := RandomReal@D;
Show@Graphics@Line@88r, r<, 8r, r<<DD, PlotRange Ø 880, 1<, 80, 1<<D

This simply plots a random line segment within the square -1 § x § 1, -1 § y § 1. (Reenter this a couple of times to observe the difference in the results.) Now enter the following
several times. You should observe forty random segments each time.
Graphics@Table@Line@88r, r<, 8r, r<<D, 840<D,
PlotRange Ø 880, 1<, 80, 1<<D

Let’s now give random color and thickness to the segments. Enter this a few times:
Graphics@Table@
8RGBColor@r, r, rD, Opacity@‰-1.5 r D, Thickness@.01 + .02 rD,
Line@88r, r<, 8r, r<<D<, 840<D, PlotRange Ø 880, 1<, 80, 1<<D

Now create a composite graphic by entering
GraphicsRow@Table@Graphics@Table@8RGBColor@r, r, rD,
Thickness@.003 + .01 rD, Line@88r, r<, 8r, r<<D<, 840<DD, 85<DD

Enter the following to produce an animated piece on a black background:
Animate@Graphics@k; Table@
8RGBColor@r, r, rD, Opacity@.9 ‰-2 r D, Thickness@.01 + .02 rD,
Polygon@88r, r<, 8r, r<, 8r, r<<D<, 830<D,
PlotRange Ø 880, 1<, 80, 1<<, Background Ø BlackD, 8k, 1, 20<D

Repeat the animation above, replacing the Line[{{r,r},{r,r}}] primitive with
a) Circle[.25{1+2r,1+2r},7 r/5]
b) Disk[{r,r}, .5r]

c) Polygon[{{r,r},{r,r},{r,r}}]

1.8 Avoiding and Getting Out of Trouble
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1.8 Avoiding and Getting Out of Trouble
Ÿ A Top Eleven List: Causes of Mathematica Problems
11. Forgetting that the natural log function is Log, not Ln
This is not peculiar to Mathematica; many advanced texts use this convention.
However, if this bothers you, you can always define Ln[x_]:= Log[x].

10. Typing an equation with one equal sign (=) instead of two (==)
A single equal sign is used only for assignments; an equation requires two. Recovering from this mistake often requires that you Clear a variable.

9. Forgetting to type a space between multiplied expressions
For example, if you accidentally type xSin[x], Mathematica assumes that you are
refering to a function named xSin.

8. Using parentheses instead of brackets or braces (or vice-versa)
Parentheses, brackets, and braces have very specific and different uses. Parentheses
are used only for grouping within expressions, brackets enclose function arguments,
and braces enclose members of a list.

7. Forgetting to load a package before referencing something in it
To correct the “shadowing” problem that results from this, you can enter
Remove[object] where object is what you tried to use prior to loading the package.

6. Entering a command that relies on a previous definition that has
not been entered during the current session
Whenever you resume work from a previous session, be sure that you re-enter
commands in order from the top of your Mathematica notebook.

5. Doing an enormous symbolic computation instead of a simple
numerical computation
See † Symbolic versus Numerical Computation below.

4. Making multiple definitions for one variable or function name
See † Multiple Definitions and Using the Question Mark below.

3. Spelling errors (including capitalization)
Enough said.

2. Forgetting to use a Blank when defining a function
See Section 1.3.

1. Forgetting to save your work before the inevitable crash
A word to the wise…

‡ What to Do When You Run into Trouble
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‡ What to Do When You Run into Trouble
„ Check for spelling mistakes, typos, and other syntax errors.
„ Look for online help.
You can access the Documentation Center through the Help menu or by simply pressing
your “help” key. If you want help on a particular command, option, etc., highlight that item
before pressing “help.”
„ Clear variable names.
Remember that entering Clear[var1, var2,…] clears variables.
„ Clear everything.
Here’s a quick way to clear all previous definitions:
ClearAll@"Global`*"D

„ Quit and restart the kernel.
Do this by choosing Quit Kernel: Local from your Kernel menu. You can then choose Start
Kernel: Local from your Kernel menu or simply enter a command to start a new kernel
session.
„ Quit and restart Mathematica.
Be sure to save your work first.
„ Quit Mathematica and restart your computer.
Again, be sure to save your work.
„ Quit and restart your day. (Just kidding.)
Seriously though, if you get frustrated, take a break!
¤ Important note: Although Mathematica remembers everything you enter during a particular session, it does not remember anything from a previous session or anything prior to
clearing all variables or restarting the kernel. Since much of what you do in Mathematica
depends on previously entered commands, you must be careful to reënter the commands that
are needed after clearing all variables or restarting the kernel.

‡ Interrupting Calculations
You will occasionally enter a command that takes Mathematica a very long time to evaluate.
To stop a computation, select Abort Evaluation from the Evaluation menu. The keyboard
shortcut for this is Ì-. (command-period) on a Macintosh and ‚-C on an Windows PC.
It is often necessary to press these keys repeated to interrupt a calculation, and sometimes
there is no alternative but to quit the kernel.

‡ Interpreting Mathematica Output When Things Don’t Work

Mathematica Basics

41

‡ Interpreting Mathematica Output When Things Don’t Work
In many circumstances, Mathematica will give you a useful error message when a bad
command is entered. Here are two examples:
PlotAx2 , 80, 1<E

Plot::pllim : Range specification 80, 1< is not of the form 8x, xmin, xmax<. à

PlotAx2 , 80, 1<E

SolveAx2 + 5 x = 2, xE
Set::write : Tag Plus in 5 x + x2 is Protected. à
Solve::eqf : 2 is not a well-formed equation. à

Solve@2, xD

However, it is very common for Mathematica simply to give a problematic command back
to you with no message. Mathematica does this whenever the syntax is correct, but no
currently defined rules affect the result. For example,
aFunctionNotEntered@0D
aFunctionNotEntered@0D

and
Ln@1D
Ln@1D

¤ When Mathematica simply gives a command back to you with no error message, it means
that the syntax is okay, but something in the command is unrecognizable.

‡ Symbolic Versus Numerical Computation
It is easy to run into major trouble by inadvertently asking Mathematica to create a huge
symbolic expression. This is most likely to happen as a result of doing some kind of recursive calculation. For example, suppose we want to calculate several terms in the sequence
defined by
x0 = 1 and xk+1 = 3 sin xk - xk for k = 0, 1, 2, …
Here is a typical Mathematica approach: We’ll define the function
f@x_D := 3 Sin@xD - x

and use NestList to compute terms in the sequence. This computes the first five terms:
NestList@f, 1, 4D

81, -1 + 3 Sin@1D, 1 - 3 Sin@1D - 3 Sin@1 - 3 Sin@1DD, -1 + 3 Sin@1D +
3 Sin@1 - 3 Sin@1DD + 3 Sin@1 - 3 Sin@1D - 3 Sin@1 - 3 Sin@1DDD,
1 - 3 Sin@1D - 3 Sin@1 - 3 Sin@1DD - 3 Sin@1 - 3 Sin@1D - 3 Sin@1 - 3 Sin@1DDD 3 Sin@1 - 3 Sin@1D - 3 Sin@1 - 3 Sin@1DD 3 Sin@1 - 3 Sin@1D - 3 Sin@1 - 3 Sin@1DDDD<

This is not exactly what we had in mind, is it? If we had asked for ten terms instead of five,
the result would have filled several pages. (Try it.) If we had asked for thirty terms, and if
the computation had eventually succeeded, the result would have contained more than 1/2
billion copies of the expression Sin! (Do yourself a favor; don’t try it.)
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This is not exactly what we had in mind, is it? If we had asked for ten terms instead of five,
the result would have filled several pages. (Try it.) If we had asked for thirty terms, and if
the computation had eventually succeeded, the result would have contained more than 1/2
billion copies of the expression Sin! (Do yourself a favor; don’t try it.)
So what should we do? We simply need to coerce Mathematica into doing the calculation
numerically instead of symbolically, which is what we wanted to begin with! One simple
way to do this is to start the sequence with the real number 1. instead of the integer 1. (Can
you think of two other ways to accomplish the same thing?)
f@x_D := 3 Sin@xD - x; NestList@f, 1., 30D

81., 1.52441, 1.47236, 1.51312, 1.48189, 1.50626,
1.4875, 1.5021, 1.49082, 1.49959, 1.49281, 1.49807, 1.494,
1.49716, 1.49471, 1.49661, 1.49514, 1.49628, 1.4954,
1.49608, 1.49555, 1.49596, 1.49564, 1.49589, 1.4957,
1.49585, 1.49573, 1.49582, 1.49575, 1.49581, 1.49576<

¤ A useful tip: When attempting a complicated computation, start small! In other words, see
what happens when you do three steps before you try to do thirty.

‡ Multiple Definitions and Using the Question Mark
Suppose that we enter
f@xD = x2 + 3 x
3 x + x2

and we then realize that we forgot the Blank that we need to put beside the variable. So we
then enter
f@x_D = x2 + 3 x
3 x + x2

and everything seems fine. Later… when working on a different problem, we redefine f as
f@x_D = x - 2
-2 + x

This function behaves as we expect; we find that its graph is the expected straight line, etc.
But then we enter
2

g@x_D = f@xD
I3 x + x2 M

2

which does not give the function g that we expect. So what’s going on here? Mathematica
remembers our original, “erroneous” definition of the expression f[x].

Mathematica Basics

43

¤ Using the Question Mark
To get information on any variable or other object, just type its name after a question mark.
For example, to get information on f we’ll enter
?f
Global`f
f@xD = 3 x + x2
f@x_ListD := 3 x
f@x_D := Which@x § -1, 1, -1 < x § 1, -x, x > 1, -1D
f@x_, y_D := x + y

This shows us that multiple definitions are associated with f. In fact, we could cause
Mathematica to associate numerous other definitions with f:
f@x_, y_D := x + y
f@x_ListD := 3 x

Now let’s get information on f:
?f
Global`f
f@xD = 3 x + x2
f@x_ListD := 3 x
f@x_D := Which@x § -1, 1, -1 < x § 1, -x, x > 1, -1D
f@x_, y_D := x + y

When Mathematica encounters an expression involving f, it looks through the definitions
associated with f until one makes sense for that expression. For example:
f@3, 5D
8

f@13D
11

f@84, 7<D
812, 21<

f@xD
3 x + x2

As you may well imagine, this behavior of Mathematica can potentially be the source of all
kinds of trouble.
¤ The key to resolving difficulties caused by multiple definitions is to Clear the culprit
variable. If you get into a really complicated mess, try quitting the kernel or entering
ClearAll@"Global`*"D

The question mark is also useful for getting the “usage message” for built-in objects. Here
are a few examples:
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The question mark is also useful for getting the “usage message” for built-in objects. Here
are a few examples:
? Plot

Plot@ f , 8x, xmin , xmax <D generates a plot of f as a function of x from xmin to xmax .
Plot@8 f1 , f2 , …<, 8x, xmin , xmax <D plots several functions fi . à

? $DisplayFunction
$DisplayFunction gives the default setting
for the option DisplayFunction in graphics functions. à

? NestList
NestList@ f , expr, nD gives a list of the results of applying f to expr 0 through n times.

à

? ê.

expr ê. rules applies a rule or list of rules in an
attempt to transform each subpart of an expression expr. à

‡ Memory
Some of the most common difficulties that arise when using Mathematica are memory
related~or rather, lack-of-memory related. Mathematica consists of two applications~the
kernel and the front end~working together. Each of these has its own memory.

† Kernel Memory
The kernel is the part of Mathematica that does the computation. Many of the computations
done by Mathematica involve highly complex algorithms and require a great deal of memory. In addition, the kernel remembers (by default) every command entered and every
computation done in a given session. So it is easy to understand why running out of kernel
memory~or experiencing poor performance due to use of virtual memory~can happen.
There are a couple of simple things that you can do to conserve memory:
¤ Set $HistoryLength to some small value such as 10 (i.e., enter $HistoryLength=
10). This causes the kernel to forget older input and output lines. The default value of
$HistoryLength is Infinity.
¤ Use the Share command occasionally:
Share@D
1 010 880

This causes stored expressions to “share” subexpressions, thus reducing the amount of
memory used. The output shows the number of freed bytes.
Also, see † Symbolic versus Numerical Computation in the preceeding section.

† Front End Memory and File Size
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† Front End Memory and File Size
Front-end memory and notebook file size usually only become an issue when your notebook
contains a lot of graphics. While the computations that create a graphic are done by the
kernel, the code that actually produces the graphic is stored in the front end’s memory.
By deleting graphics cells~especially cells containing three-dimensional graphics or
graphics created with a high value for the PlotPoints option~you can greatly decrease
the amount of front-end memory used.
When you save your work, it is information in the front end’s memory that you are saving~
in the form of a Mathematica “notebook.” When a notebook becomes very large, you can
usually remedy the situation by deleting graphics cells before saving. Graphics can always
be reproduced, as long as the commands are saved.
¤ A handy feature is the Delete All Output item in the Cell menu. This will let you quickly
save the essence of your work in a very small file.

‡ Exercises
1. Purposely commit each of the errors described in the eleven causes of problems outlined
above~with the exception of numbers 4 and 1. In cases where no consequence is immediately evident, construct a subsequent scenario that exposes the error.

1.9 Turning a Notebook into a Report
You will likely be asked to put the work you do in Mathematica into a form that will be
presentable enough to submit to your professor. Fortunately, the Mathematica front end
serves as a very versatile word processor. In fact, this entire manual was written with
Mathematica.

‡ Cell Styles
You should always provide comments and narrative along with your calculations (whether
you’re using Mathematica or pencil and calculator). Any cell that contains text should be
given Text Style by selecting Text from the Style submenu of the Format menu before you
begin typing text into the cell. You can also give an existing cell Text Style by highlighting
the cell bracket and selecting Text from the same menu.
You should also use Title, Section, Subsection cells, etc., to organize your notebook. These
items are also in the Style submenu of the Format menu.
Aside from resulting in much nicer looking work, this is also important because when an
Input cell contains text, all kinds of errors and garbage can result if it is accidentally
evaluated.
For example notice what happens when I enter this
Â enter example For happens notice this what when
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or when I enter this.
Syntax::tsntxi : "this." is incomplete; more input is needed.
Syntax::tsntxi : "this." is incomplete; more input is needed.
Syntax::sntxi : Incomplete expression; more input is needed.

Moreover, if Input cells only contain valid Mathematica commands, it is possible to evalute
all of them in order by selecting Evaluate Notebook from the Evaluation menu without
making a big mess of your the notebook.

‡ Page Breaks
Bad page breaks usually involve a large amount of blank space at the bottom of a page.
Frequently this is caused by a graphic being just a little too large to fit on the current page.
The default size of Mathematica graphics is larger than it usually needs to be for printing.
So by resizing (i.e., shrinking) graphics, you can avoid a lot of bad page breaks. A graphic
can be resized by clicking on it and dragging a corner. Also, a good way to get smaller,
consistently-sized graphics from Plot, for instance, is to use SetOptions:
SetOptions@Plot, ImageSize Ø 200D

How can you tell where page breaks will occur before you print? You can select Show
Page Breaks from the Printing Settings submenu of the File menu. (In Mathematica 5.x,
this is located in the Format menu.)
You can also force a page break between two cells by selecting Page Break from the Insert
Menu.

‡ Other Tips
In the Printing Settings submenu of the File menu, you’ll see Printing Options... In the
resulting dialog box, you can set margins and specify whether or not to print cell brackets.
In the Style Sheet submenu of the Format menu, you can choose from among several
standard style sheets. The choice of style sheet affects the appearance of title and section
cells, background color, etc. Experiment to find one that you like. But don’t be surprised if
you end up preferring the default.

Ï Exercises
1. Write a short but detailed report (2|3 pages) in Mathematica on any one of the following
topics. Your report must include input, output, text, section, and title cells.
a) The rational root theorem for polynomials.
b) How to find the inverse of a one-to-one function.
c) Even functions and odd functions.
d) The unit circle and the graphs of sin x and cos x.
e) The compound interest formula.
f) Rational functions with slant asymptotes.

1.10 Miscellaneous Advice
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1.10 Miscellaneous Advice
‡ The Cube Root Function
When you ask Mathematica for the cube root (or any odd root) of a negative number, it
returns a complex number. This complex number is indeed the principal value the cube root
function defined on the complex numbers.
3

-8.

1. + 1.73205 Â

However, this is not what we want when we talk about the cube root function defined on the
real numbers. A simple remedy is to define your own cube root function as follows:
Cbrt@x_D := Sign@xD

3

Abs@xD

Plot@Cbrt@xD, 8x, -4, 4<D
1.5
1.0
0.5
-4

-2

-0.5

2

4

-1.0
-1.5

‡ Custom Initialization
You may find that there are certain commands you want to enter every time you run Mathematica. For instance, if you prefer that the curves drawn by Plot are always thicker than
the default thickness, you can avoid specifying that with the PlotStyle option every time
you use plot by entering
SetOptions@Plot, PlotStyle Ø Thickness@.005DD

But that will only be in effect during the current kernel session; that is, the next time you
start Mathematica, you'll have to enter that command again.
Assuming that you have appropriate priviledges on the computer on which you’re working,
you can execute a group of commands automatically each time the kernel starts up by
placing those commands in a file named init.m that’s located in a particular directory. An
easy way to find and open that file is to enter
ToFileName@8$UserBaseDirectory, "Kernel"<, "init.m"D
NotebookOpen@%D

You can type in the commands you want executed automatically upon startup and then save
and close the file. Actually, it’s best to type the commands in an open notebook, make sure
they work correctly, and then copy and paste them into the init.m file.
Here are a few examples of things you might want to put in init.m:
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Here are a few examples of things you might want to put in init.m:
•!This sets options for Plot so that it draws thicker curves and makes plots 3 inches wide.
SetOptions@Plot,
8PlotStyle Ø Thickness@MediumD, ImageSize Ø 3 * 72<D;

• This defines a real cube root function.
Cbrt@x_D := Sign@xD

3

Abs@xD ;

• This sets $HistoryLength to conserve memory.
$HistoryLength = 10

